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47 • BESTCOMSPlus® Software 
BESTCOMSPlus is a Windows®-based, PC application that provides a user-friendly, graphical user 
interface (GUI) for use with Basler Electric communicating products. The name BESTCOMSPlus is an 
acronym that stands for Basler Electric Software Tool for Communications, Operations, Maintenance, and 
Settings. 

BESTCOMSPlus provides the user with a point-and-click means to set and monitor the BE1-11m. The 
capabilities of BESTCOMSPlus make the configuration of one or several BE1-11m Motor Protection 
Systems fast and efficient. A primary advantage of BESTCOMSPlus is that a settings scheme can be 
created, saved as a file, and then uploaded to the BE1-11m at the user’s convenience. 

BESTCOMSPlus uses plugins allowing the user to manage several different Basler Electric products. The 
BE1-11 plugin must be activated before use. The plugin can be activated automatically by connecting to a 
BE1-11m or activated manually by requesting an activation key from Basler Electric. 

The BE1-11 plugin opens inside the BESTCOMSPlus main shell. The same default logic scheme that is 
shipped with the BE1-11m is brought into BESTCOMSPlus by downloading settings and logic from the 
BE1-11m or by selecting application type “M” on the Style Number screen. This gives the user the option 
of developing a custom setting file by modifying the default logic scheme or by building a unique scheme 
from scratch. 

BESTlogic™Plus Programmable Logic is used to program BE1-11m logic for protection elements, inputs, 
outputs, alarms, etc. This is accomplished by the drag-and-drop method. The user can drag elements, 
components, inputs, and outputs onto the program grid and make connections between them to create 
the desired logic scheme. 

BESTCOMSPlus also allows for downloading industry-standard COMTRADE files for analysis of stored 
oscillography data. Detailed analysis of the oscillography files can be accomplished using BESTwave™ 
software. 

Figure 47-1 illustrates the typical user interface components of the BE1-11 plugin with BESTCOMSPlus. 

 
Figure 47-1. Typical User Interface Components 
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System Recommendations 

BESTCOMSPlus software is built on the Microsoft® .NET Framework. The setup utility that installs 
BESTCOMSPlus on your PC also installs the BE1-11 plugin and the required version of .NET Framework 
(if not already installed). BESTCOMSPlus operates with systems using Windows® 7 SP1, Windows 8.1, 
and Windows 10 version 1607 (Anniversary Edition) or later. System recommendations for the .NET 
Framework and BESTCOMSPlus are listed in Table 47-1. 

Table 47-1. System Recommendations for BESTCOMSPlus and the .NET Framework 

System Type Component Recommendation 
32/64 bit Processor 2.0 GHz 
32/64 bit RAM 1 GB (minimum), 2 GB (recommended) 

32 bit Hard Drive 200 MB (if .NET Framework is already installed on PC) 
4.5 GB (if .NET Framework is not already installed on PC) 

64 bit Hard Drive 200 MB (if .NET Framework is already installed on PC) 
4.5 GB (if .NET Framework is not already installed on PC) 

To install BESTCOMSPlus, a Windows user must have Administrator rights. 

Installation 
 

Note 
Do not connect a USB cable until setup completes successfully. 
Connecting a USB cable before setup is complete may result in 
unwanted or unexpected errors. 

Run the setup file for the BESTCOMSPlus application. The setup utility installs BESTCOMSPlus, the 
.NET Framework (if not already installed), the USB driver, and the BE1-11 plugin for BESTCOMSPlus on 
your PC. 

When BESTCOMSPlus installation is complete, a Basler Electric folder is added to the Windows 
programs menu. This folder is accessed by clicking the Windows Start button and then accessing the 
Basler Electric folder in the Programs menu. The Basler Electric folder contains an icon that starts 
BESTCOMSPlus when clicked. 

Activate the BE1-11 Plugin for BESTCOMSPlus® 

The BE1-11 plugin is a module that runs inside the BESTCOMSPlus shell. The BE1-11 plugin contains 
specific operational and logic settings for only the BE1-11m. Uploading settings to the BE1-11m is 
possible only after activating the BE1-11 plugin. 

The BE1-11 plugin can be activated automatically or manually. Automatic activation is achieved by using 
a USB cable to establish communication between the BE1-11m and BESTCOMSPlus. Manual activation 
is initiated by contacting Basler Electric for an activation key and entering the key into BESTCOMSPlus. 
Manual activation is useful if you want to create a settings file prior to receiving your BE1-11m. Note that if 
a BE1-11m is not connected, you will not be able to configure certain Ethernet settings. Ethernet settings 
can be changed only when an active USB or Ethernet connection is present. Refer to the Communication 
chapter. 

Connect a USB Cable 
The USB driver was copied to your PC during BESTCOMSPlus installation and is installed automatically 
after powering the BE1-11m. USB driver installation progress is shown in the Windows taskbar area. 
Windows will notify you when installation is complete. 
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Connect a USB cable between the PC and your BE1-11m. Apply operating power (per style chart in the 
Introduction chapter) to the BE1-11m at rear terminals A6 and A7. Wait until the boot sequence is 
complete. 

Note 

In some instances, the Found New Hardware Wizard will prompt you 
for the USB driver. If this happens, direct the wizard to the following 
folder: 

C:\Program Files\Basler Electric\USB Device Drivers\ 

If the USB driver does not install properly, refer to the Troubleshooting chapter. 

Start BESTCOMSPlus® and Activate BE1-11 Plugin Automatically 
To start BESTCOMSPlus, click the Start button, point to Programs, Basler Electric, and then click the 
BESTCOMSPlus icon. During initial startup, the BESTCOMSPlus Select Language screen is displayed 
(Figure 47-2). You can choose to have this screen displayed each time BESTCOMSPlus is started, or you 
can select a preferred language and this screen will be bypassed in the future. Click OK to continue. This 
screen can be accessed later by selecting Tools and Select Language from the menu bar. 

 
Figure 47-2. BESTCOMSPlus Select Language Screen 

The BESTCOMSPlus splash screen is shown for a brief time. See Figure 47-3. 

 
Figure 47-3. BESTCOMSPlus Splash Screen 

The BESTCOMSPlus platform window opens. Select New Connection from the Communication pull-down 
menu and select BE1-11. See Figure 47-4. The BE1-11 plugin is activated automatically after connecting 
to a BE1-11m. 

The BE1-11 Connection screen shown in Figure 47-5 appears. Select USB Connection and then click the 
Connect button. 
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The BE1-11 plugin opens indicating that activation was successful. You can now configure the BE1-11m 
communication ports and other BE1-11m settings. 

 
Figure 47-4. Communication Pull-Down Menu 

 
Figure 47-5. BE1-11 Connection Screen 

Manual Activation of the BE1-11 Plugin 
Manual activation of the BE1-11 plugin is required only if your initial use of BESTCOMSPlus will be on a 
PC that is not connected to a BE1-11m. Manual activation is described in the following paragraphs. 

Requesting an Activation Key 

When initially running the BE1-11 plugin, the Activate Device Plugin pop-up appears. You must contact 
Basler Electric for an activation key before you can activate the BE1-11 plugin. Click the Email button to 
request an activation key from Basler Electric. Once you receive your activation key, click the Activate 
button. See Figure 47-6. 
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Figure 47-6. Device Plugin Requires Activation 

The Activate Device Plugin pop-up appears. Refer to Figure 47-7. 

 
Figure 47-7. Activate Device Plugin 

Entering an Activation Key 

Select BE1-11 from the Device pull-down menu. Enter your Email Address and Activation Key provided 
by Basler Electric. If you received an email containing the Activation Key, you can select all of the text in 
the email and copy it to the Windows clipboard using normal Windows techniques as shown in Figure 
47-8. 

The Get Data button extracts the Device, Email Address, and Activation Key from the Windows clipboard 
and pastes it into the appropriate fields. See Figure 47-9. Click the Activate button to continue. The 
Activate Device Plugin screen is also found by selecting Activate Device from the Tools pull-down menu 
of the BESTCOMSPlus main screen. 
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Figure 47-8. Activation Key Email 

 
Figure 47-9. Activate Device Plugin 

Establishing Communication 
Communication between BESTCOMSPlus and the BE1-11m is established by clicking on the Connect 
button on the BE1-11 Connection screen (see Figure 47-5) or by clicking on the Connect button on the 
lower menu bar of the main BESTCOMSPlus screen (Figure 47-1). If you receive an “Unable to Connect 
to Device” error message, verify that communications are configured properly. Only one Ethernet 
connection is allowed at one time. Download all settings and logic from the BE1-11m by selecting 
Download Settings and Logic from the Communication pull-down menu. BESTCOMSPlus will read all 
settings and logic from the BE1-11m and load them into BESTCOMSPlus memory. See Figure 47-10. 

 
Figure 47-10. Processing, Please Wait… 
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Advanced Properties 

Click the Advanced button on the Connection screen to display the Advanced Properties dialog. Default 
settings are shown in Figure 47-11. 

 
Figure 47-11. Advanced Properties Dialog 

Menu Bars 

The menu bars are located near the top of the BESTCOMSPlus screen (see Figure 47-1). The upper 
menu bar has five pull-down menus. With the upper menu bar, it is possible to manage settings files, 
configure communication settings, upload and download settings/security files, and compare settings 
files. The lower menu bar consists of clickable icons. The lower menu bar is used to change 
BESTCOMSPlus views, open a settings file, connect/disconnect, preview metering printout, export 
metering, switch to live mode, and send settings after a change is made when not in live mode. 

Upper Menu Bar (BESTCOMSPlus® Shell) 
Upper menu bar functions are listed and described in Table 47-2. 

Table 47-2. Upper Menu Bar (BESTCOMSPlus Shell) 

Menu Item Description 
File 

New Create a new settings file 

Open Open an existing settings file 

Close Close settings file 

Save Save settings file 

Save As Save settings file with a different name 

Export To File Save settings as a *.csv file 

Print Print, export, or send a settings file 

Properties View properties of a settings file 

History View history of a settings file 

Recent Files Open a previously opened file 

Exit Close BESTCOMSPlus program 

Communication 
New Connection Choose new device or BE1-11 
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Menu Item Description 
Close Connection Close communication between BESTCOMSPlus and BE1-11 

Download Settings and Logic from 
Device 

Download operational and logic settings from the device 

Upload Settings and Logic to 
Device 

Upload operational and logic settings to the device 

Upload Settings to Device Upload operational settings to the device 

Upload Logic to Device Upload logic settings to the device 

Download Security from Device Download security settings from the device 

Upload Security to Device Upload security settings to the device 

Certificate - Upload Certificate to 
Device 

Upload certificate to the device 

Certificate - Remove Certificate 
from Device 

Remove certificate from the device 

Reset to Factory Defaults Reset factory defaults in the BE1-11m 
(Available only when the device does not contain default settings. 
Administrator access level required.) 

Upload Settings, Logic and 
Security 

Upload operational, logic, and security settings to the device 
(Available only when the device contains default settings. No password 
required.) 

Configure Ethernet settings 

Upload Device Files Upload firmware to the device 

Upgrade Style Number Upload a style upgrade file supplied by Basler Electric 

Tools 
Select Language Select BESTCOMSPlus language 

Activate Device Activate the BE1-11 plugin 

Set File Password Password protect a settings file 

Compare Settings Files Compare two settings files 

Copy Settings Group Copy Settings from Group to Group 

Auto Export Metering Exports metering data at a user-defined interval 

Launch BEST61850™ Opens BEST61850 (if installed) 

Event Log - View View the BESTCOMSPlus event log 

Event Log - Verbose Logging Enable/disable verbose logging 

Event Log - Verbose 
Communication Logging 

Enable/disable verbose communication logging 

Set Default Shell Select the default shell for BESTCOMSPlus 

Generate Certificate Generate a certificate 

Accepted Devices View and delete accepted devices 

Help 
Check for Updates Check for BESTCOMSPlus updates via the internet 

Check for Update Settings Enable or change automatic checking for updates 

About View general, detailed build, and system information 

Lower Menu Bar (BE1-11 Plugin) 
Lower menu bar functions are listed and described in Table 47-3. 
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Table 47-3. Lower Menu Bar (BE1-11 Plugin) 

Menu Button Description 

 
Enables you to show/hide the Metering Panel, Settings Panel, or Settings 
Info Panel. 
Opens and saves workspaces. Customized workspaces make switching 
between tasks easier and more efficient. 

 
Opens a saved settings file. 

 
Opens the BE1-11 Connection screen which enables you to connect to 
the BE1-11m via USB or Ethernet. This button appears only when a 
BE1-11m is not connected. 

 
Used to disconnect a connected BE1-11m. This button appears only 
when a BE1-11m is connected. 

 
Displays the Print Preview screen where a preview of the Metering 
printout is shown. Click on the printer button to send to a printer. 

 
Enables all metering values to be exported into a *.csv (comma-
separated values) file. 

 

 

A pull-down menu allowing group selection is available when making 
protection settings. The settings can be applied to Group 0, 1, 2, or 3. If a 
global setting is being changed, Global will appear in place of the drop-
down menu. 

 
Displays a drop-down list entitled Live Mode Settings which enables Live 
mode where settings are automatically sent to the device in real time as 
they are changed. The changed device settings are saved to non-volatile 
memory by clicking on the Save button. 

 
Saves all device settings to non-volatile memory. This button appears 
only when operating in Live mode. 

 
Sends settings to the BE1-11 when BESTCOMSPlus is not operating in 
Live Mode. Click this button after making a setting change to send the 
modified setting to the BE1-11m. 

Settings Explorer 

The Settings Explorer is a convenient tool within BESTCOMSPlus used to navigate through the various 
settings screens of the BE1-11 plugin. Descriptions of these configuration settings are organized as 
follows: 

• General Settings 
• Communications 
• System Parameters 
• Programmable Inputs 
• Programmable Outputs 
• Alarm Configuration 
• Metering Configuration 
• Target Configuration 
• Protection 
• Control 
• BESTlogicPlus Programmable Logic 

Logic setup will be necessary after making certain setting changes. For more information, refer to the 
BESTlogicPlus chapter. 



47-10  9424200996 

BESTCOMSPlus® Software  BE1-11m 

Settings Entry 

When entering settings in BESTCOMSPlus, each setting is validated against prescribed limits. Entered 
settings that do not conform with the prescribed limits are accepted but flagged as noncompliant. Figure 
47-12 illustrates an example of flagged, noncompliant settings (locator A) and the Setting Validation 
window (locator B) used to diagnose faulty settings.  

 
Figure 47-12. Flagged, Noncompliant Settings and the Seting Validation Window 

The Setting Validation window, viewed by selecting the Setting Validation tab (locator C), displays three 
types of annunciations: errors, warnings, and messages. An error describes a problem such as a setting 
that is out of range. A warning describes a condition where supporting settings are invalid, causing other 
settings to be noncompliant with the prescribed limits. A message describes a minor setting issue that 
was automatically resolved by BESTCOMSPlus. An example of a condition triggering a message is entry 
of a settings value with a resolution that exceeds the limit imposed by BESTCOMSPlus. In this situation, 
the value is automatically rounded and a message is triggered. Each annunciation lists a hyperlinked 
name for the noncompliant setting and an error message describing the issue. Clicking the hyperlinked 
setting name takes you to the setting screen with the offending setting. Right-clicking the hyperlinked 
setting name will restore the setting to its default value. 
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Note 
It is possible to save a BE1-11 settings file in BESTCOMSPlus with 
noncompliant settings. However, it is not possible to upload 
noncompliant settings to the BE1-11. 

Metering Explorer 

The Metering Explorer is described in the Metering chapter. 

Settings File Management 

A settings file contains all BE1-11m settings including logic. 

A settings file created in BESTCOMSPlus will have one of two file extensions. Settings files created in 
version 4.00.00 and later are given an extension of “bst4”. Settings files created in versions prior to 
4.00.00 will have an extension of “bstx”. 

It is possible to save only the BE1-11m logic displayed on the BESTlogicPlus Programmable Logic screen 
as a separate logic library file. This ability is helpful when similar logic is required for several BE1-11m 
systems. The file extension of a logic file created in BESTCOMSPlus will be either “bsl4” (version 4.00.00 
and later) or “bslx” (versions prior to 4.00.00).  

It is important to note that settings and logic can be uploaded to the device separately or together, but are 
always downloaded together. For more information on logic files, refer to the BESTlogicPlus chapter. 

Opening a Settings File 
To open a BE1-11m settings file with BESTCOMSPlus, pull down the File menu and choose Open. The 
Open dialog box appears. This dialog box allows you to use normal Windows techniques to select the file 
that you want to open. Select the file and choose Open. You can also open a file by clicking on the Open 
File button on the lower menu bar. If connected to a device, you will be asked to upload the settings and 
logic from the file to the current device. If you choose Yes, the settings displayed in BESTCOMSPlus 
instance will be overwritten with the settings of the opened file. 

Saving a Settings File 
Select Save or Save As from the File pull-down menu. A dialog box pops up allowing you to enter a 
filename and location to save the file. Select the Save button to complete the save. 

Upload Settings and/or Logic to Device 
To upload a settings file to the BE1-11m, open the file or create a new file through BESTCOMSPlus. Then 
pull down the Communication menu and select Upload Settings and Logic to Device. If you want to 
upload operational settings without logic, select Upload Settings to Device. If you want to upload logic 
without operational settings, select Upload Logic to Device. You are prompted to enter the username and 
password. The default username is “A” and the default password is “A”. If the username and password 
are correct, the upload begins and the progress bar is shown. 

Upload Settings, Logic, and Security to Device 
This function is available only when the device contains default settings. A password is not required. To 
upload settings, logic, and security to the BE1-11m, pull down the Communication menu and select 
Upload Settings, Logic, and Security. 



47-12  9424200996 

BESTCOMSPlus® Software  BE1-11m 

Download Settings and Logic from Device 
To download settings and logic from the BE1-11m, pull down the Communication menu and select 
Download Settings and Logic from Device. If the settings in BESTCOMSPlus have changed, a dialog box 
will open asking if you want to save the current settings changes. You can choose Yes or No. After you 
have taken the required action to save or discard the current settings, downloading begins. 
BESTCOMSPlus reads all settings and logic from the BE1-11m and loads them into BESTCOMSPlus 
memory. See Figure 47-13. 

 
Figure 47-13. Processing, Please Wait… 

Printing a Settings File 
To view a preview of the settings printout, select Print Preview from the File pull-down menu. To print the 
settings, select the printer icon in the upper left corner of the Print Preview screen. 

You can skip the print preview and go directly to print by pulling down the File menu and selecting Print. A 
Print dialog box opens with the typical Windows choice to setup the properties of printer. Execute this 
command, as necessary, and then select Print. 

Comparing Settings Files 
BESTCOMSPlus has the ability to compare two settings files. To compare files, pull down the Tools menu 
and select Compare Settings Files. The BESTCOMSPlus Settings Compare Setup dialog box appears 
(Figure 47-14). Select the location of the first file under Left Settings Source and select the location of the 
second file under Right Settings Source. If you are comparing a settings file located on your PC hard 
drive or portable media, click the folder button and navigate to the file. If you want to compare settings 
from a unit, click the Download settings from unit button to set up the communication port. Click the 
Compare button to compare the selected settings files. 

 
Figure 47-14. BESTCOMSPlus Settings Compare Setup 

A dialog box will appear and notify you if any differences were found. The BESTCOMSPlus Settings 
Compare dialog box (Figure 47-15) is displayed where you can select to view all settings, settings 
differences, all logic paths, logic path differences, all DNP/Modbus options, or DNP/Modbus differences. If 
a settings file based on an older version of firmware was uploaded into the BE1-11m, the BE1-11m could 
contain additional settings that did not exist when the original settings file was created. The settings 
compare function detects these differences and displays them when the Include Missing box is checked. 
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Uncheck this box to ignore differences due to the additional settings. Click Print to print a report or click 
Close to close the window. 

 
Figure 47-15. BESTCOMSPlus Settings Compare 

Auto Export Metering 

The auto export metering function automatically exports metering data over a user-defined period. The 
user specifies the Number of Exports and the Interval between each export. Enter a filename for the 
metering data and a folder in which to save. The first export is performed immediately after clicking the 
Start button. Click the Filter button to select specific metering screens. Figure 47-16 illustrates the Auto 
Export Metering screen. 

 
Figure 47-16. Auto Export Metering 
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BESTCOMSPlus Updates 

Ongoing BE1-11m functionality enhancements may make future BE1-11m firmware updates desirable. 
Enhancements to BE1-11m firmware typically coincide with enhancements to the BE1-11 plugin for 
BESTCOMSPlus. When a BE1-11m is updated with the latest version of firmware, the latest version of 
BESTCOMSPlus should also be obtained. 

• You can download the latest version of BESTCOMSPlus by visiting www.basler.com. 

• BESTCOMSPlus automatically checks for updates when Check Automatically is selected on the 
Check for Updates User Settings screen. This screen is accessed under the Help drop-down 
menu. (An internet connection is required.) 

• You can use the manual “check for updates” function in BESTCOMSPlus to ensure that the latest 
version is installed by selecting Check for Updates in the Help drop-down menu. (An internet 
connection is required.) 

Firmware Updates 

For information on updating firmware, refer to the Device Information chapter. 

https://www.basler.com/
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